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User manual

STM32W-SK and STM32W-EXT starter and extension kits
 for STM32W108xx microcontrollers

Introduction

The STM32W-SK and STM32W-EXT starter and extension kits are easy to use tools for the 
STM32W108xx microcontrollers. This family of microcontrollers integrates a 32-bit ARM® 
Cortex™-M3 microprocessor and a 2.4 GHz, IEEE 802.15.4-compliant transceiver. The kits 
demonstrate how effectively the STM32W108xx can be used in real IEEE 802.15.4 
applications. They are suitable for different types of wireless network scenarios such as:

• Remote control and target networks (based on the ZigBee RF4CE protocol stack) used 
for driving consumer devices such as TVs, set-top boxes, etc.

• Point to point networks (based on a Simplified MAC library) used to address a basic 
IEEE 802.15.4 communication. This configuration enables customers to develop any 
protocol stack of their choice.

The STM32W108xx kits provide demonstration applications and documentation which serve 
as a reference for creating your own applications and re-programming the STM32W108xx 
microcontroller. You can run the STM32W108xx kits in several ways (remote control/target 
and point-to-point applications), using the dedicated software libraries (ZigBee RF4CE, and 
Simplified MAC), as well as a third-party IDE and C compiler (IAR).

Moreover, the STM32W108xx kits provide a set of APIs which allow you to use the kit 
platform capabilities such as LEDs and serial communication channels (virtual COM through 
USB).

In this manual, you can find information about:

• The STM32W108xx kits components

• How to install the related hardware and software trees

Note: The term “application board” refers to the MB851 and MB954 platforms.

For more information, visit the STM32W 32-bit RF microcontroller webpages at 
www.st.com/stm32w.

This web page provides full access to all the STM32W108xx resources (kits, software 
packages and documents).

Table 1 lists the evaluation tools concerned by this user manual.

         

Table 1. Applicable tools

Type Applicable tools

Evaluation tools STM32W-SK and STM32W-EXT starter and extension kits

www.st.com

http://www.st.com
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1 Getting started

This section provides a complete description of the STM32W-SK and STM32W-EXT kit’s 
hardware and software.

There are two types of STM32W108xx kits:

• The starter kit (order code: STM32W108C-SK)

• The extension kit (order code: STM32W108C-KEXT)

Note: 1. Order code STM32W108B-KEXT is replaced by STM32W108C-KEXT.

2. STM32W108C-SK and STM32W108C-KEXT contain STM32W108CC (256-Kbyte Flash).

3. STM32W108B-SK and STM32W108B-KEXT contain STM32W108xB (128-Kbyte Flash).

1.1 Kit description

1.1.1 Hardware

STM32W108B-SK

The STM32W108xx starter kit package (STM32W108B-SK) contains the following hardware 
components: 

• Two STM32W108 application boards (MB851) 

• One STM32W108 extension board (MB850)

• One Raisonance STM32-Primer2 tool (STM3210E-PRIMER)

• One J-Link Lite JTAG Flash programmer and debugger

• One mini USB cable

• Four AAA batteries

Figure 1. STM32W108B-SK starter kit

Network Analyzer (Perytons)

J-Link Lite +
IAR compiler

MB850 
extension board

+
STM32-Primer2

MB851 application board x2
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STM32W108C-SK

The STM32W108xx starter kit package (STM32W108C-SK) contains the following 
hardware components:

• Two STM32W108 application boards (MB851)

• One STM32W108 USB Dongle (MB951)

• One J-Link Lite JTAG Flash programmer and debugger

• One mini USB cable

• Four AAA batteries

Figure 2. STM32W108C-SK starter kit

Network analyzer (Perytons)

J-Link Lite +
IAR compiler

MB951 
USB dongle
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STM32W-EXT

The extension kit package contains two STM32W108 application boards (MB851) and two 
STM32W108 application boards with a power amplifier (MB954).

         

Note: For information concerning the STM32W108xx application boards, refer to the STM32W 32-
bit RF microcontroller webpages at www.st.com/stm32w.

1.2 Revision numbers of STM32W108xx starter and extension kit 
boards 

Table 2 details the STM32W108xB starter and extension kit board revision numbers versus 
those of the STM32W108CC.

         .

NA = Not applicable

1.3 MB850 hardware description

1.3.1 MB850 resources

None 

Figure 3. MB851 application board Figure 4. MB954 application board with a power 
amplifier 

                  

Table 2. Boards revision numbers

STM32W108xB (128K Flash) STM32W108CC (256K Flash)

MB851 Revision A, B, C Revision D

MB954 Revision A, B Revision C

MB951 NA Revision B

MB850 Revision A NA
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1.3.2 MB850 connectors

Table 3 lists the connectors available in the MB850 board and their functions.

         

1.3.3 MB850 connectors: JP1 pins

         

1.3.4 MB850 connectors: JP2 pins

         

Table 3. MB850 connectors

Type Label Function

Header 6H JP1 SWD debug

Header 10X2 JP2 Connector to Primer2 board

Table 4. MB850 connectors: JP1 pins

Pin number GPIO/ Function

1 +2V8

2 GND

3 PC0/JRST

4 SWCLK/JTCK

5 PC4/SWDIO/JTMS

6 nRST

Table 5. MB850 connectors: JP2 pins

Pin number GPIO/ Function

1 +2V8

2 GND

3 NC

4 NC

5 PA0

6 PA1

7 PA2

8 PA3

9 NC

10 NC

11 nRST

12 PA5

13 NC

14 PB4

15 PB3
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1.3.5 MB850 jumper configuration

None

1.3.6 MB850 PC interface chip

None

1.3.7 MB850 battery holder

None

1.4 MB951 hardware description

1.4.1 MB951 resources

Table 6 lists the resources available in the MB951 board to develop applications and their 
connection with STM32W108 pins.

         

Note: MB951 revision A is not used in any of the STM32W108xx starter and extension kits. 

1.4.2 MB951 connectors

Table 7 lists the connectors available in the MB951 board and their functions.

         .

16 PB2

17 NC

18 PB1

19 NC

20 GND

Table 5. MB850 connectors: JP2 pins (continued)

Pin number GPIO/ Function

Table 6. MB951 board resources to develop applications and connection

Type Label Part
Rev B

STM32W108 pin

Button S1 PA3

LED D1 PA5

LED D3 PA0

Table 7. MB951 board connectors

Type Label Function 

USB P1 PC I/O
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1.4.3 MB951 jumpers configuration

None

1.4.4 MB951 PC Interface chip

Table 8 lists the PC interface chip available in the MB951 board to allow I/O interface to the 
STM32W108.

         

1.4.5 MB951 battery holder

None

1.5 MB851 hardware description

1.5.1 MB851 resources

Table 9 lists the resources available in the MB851 board to develop applications and their 
connection with STM32W108 pins.

         

Table 8. PC interface chip

Type Part

PC I/O interface STM32F103TBU6

Table 9. MB851 resources

Type Label Part
Rev A Rev B Rev C, D

STM32W108 pin

Button RST1

Button S1 PA7 PA7 PB3

I²C EEPROM U4
M24C64MW1

128 KBytes
NA NA PA1, PA2

LED D1 PB6 PB6 PA5

LED D3 PB5 PB5 PA0

LED D5 Infrared LED PB4 PB4 PB4

Mems U2 LIS302 PA1, PA2 PA1, PA2 PA1, PA2

Temperature 
sensor

U3 STLM20 PB7 PB7 PA4
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1.5.2 MB851 connectors

Table 10 lists the connectors available in the MB851 board and their functions.

         

1.5.3 MB851 connectors: P1 pins

         

Table 10. MB851 connectors

Type Label Function

Mini USB J2 PC I/O

Header, 14-pin, dual row male P1 GPIO access

Header, 10-pin, dual row male P4 Standard JTAG debug

Table 11. MB851 connectors: P1 pins

Pin number GPIO function

1 +VBRD

2 PC5

3 nRST

4 PA7

5 PB3

6 PB4

7 PA0

8 PA1

9 PA2

10 PA4

11 PA3

12 PA6

13 PA5

14 GND

15 PB1

16 PB2

17 JTCK

18 PC2

19 PC3

20 PC4

21 GND

22 GND

23 PB0

24 PC1
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1.5.4 MB851 connectors: P4 pins

         

25 PC0

26 PB7

27 PB6

28 PB5

Table 11. MB851 connectors: P1 pins (continued)

Pin number GPIO function

Table 12. MB851 connectors: P4 pins

Pin number GPIO function

1 +VBRD

2 +VBRD

3 PC0

4 GND

5 PC3

6 GND

7 PC4

8 GND

9 JTCK

10 GND

11 GND

12 GND

13 PC2

14 GND

15 nRST

16 GND

17 GND

18 GND

19 +VJTAG

20 GND
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1.5.5 MB851 jumper configuration

Table 13 lists the jumpers configurations on the MB851 board. 

         

1.5.6 MB851 PC interface chip

Table 14 lists the PC interface chip available in the MB851 board to allow I/O interface to the 
STM32W108.

         

1.5.7 MB851 battery holder

         

1.6 MB954 hardware description

1.6.1 MB954 resources

Table 16 lists the resources available in the MB954 board to develop applications and their 
connection with STM32W108 pins.

         

Table 13. MB851 jumper configuration

Label Configuration

JP1
Power Mems, temperature sensor and 

infrared LED

P2

1-2: battery powered

2-3: reserved

3-4: USB or JTAG powered

Table 14. MB851 PC Interface chip

Revision Type Part

Rev. A PC I/O FTDI FT232R

Rev. B PC I/O FTDI FT232R

Rev. C, D PC I/O STM32F103TBU6

Table 15. MB851 battery holder

Type Label

2x AAA battery holder BT1

Table 16. MB954 resources

Type Label Part
Rev. A Rev. B, C

GPIO GPIO

Button RST1

Button S1 PB3 PB3
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1.6.2 MB954 connectors

Table 17 lists the connectors available in the MB954 board and their functions.

         

1.6.3 MB954 connectors: P1 pins

         

I²C EEPROM U4
M24C64MW1

128 KBytes
Not fitted PA2

LED PA5 PA5

LED D3 PA0 PA0

LED D5 Infrared LED PB4 PB4

Mems U2 LIS302 PA1, PA2 PA1, PA2

Temperature 
sensor

U3 STLM20 PA4 PA4

Table 16. MB954 resources (continued)

Type Label Part
Rev. A Rev. B, C

GPIO GPIO

Table 17. MB954 connectors

Type Label Function

Mini USB J2 PC I/O

Header, 14-pin, dual row male P1 GPIO access

Debug connector P4 Standard JTAG debug

Table 18. MB954 connectors: P1 pins

Name GPIO function

1 +VBRD

2 PC5

3 nRST

4 PA7

5 PB3

6 PB4

7 PA0

8 PA1

9 PA2

10 PA4

11 PA3

12 PA6

13 PA5

14 GND

15 PB1
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1.6.4 MB954 connectors: P4 pins

         

16 PB2

17 JTCK

18 PC2

19 PC3

20 PC4

21 GND

22 GND

23 PB0

24 PC1

25 PC0

26 PB7

27 PB6

28 PB5

Table 18. MB954 connectors: P1 pins (continued)

Name GPIO function

Table 19. MB954 connectors: P4 pins

Name GPIO function

1 +VBRD

2 +VBRD

3 PC0

4 GND

5 PC3

6 GND

7 PC4

8 GND

9 JTCK

10 GND

11 GND

12 GND

13 PC2

14 GND

15 nRST

16 GND

17 GND

18 GND

19 +VJTAG

20 GND
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1.6.5 MB954 jumper configuration

Table 20 lists the jumpers configurations in the MB954 board.

         

1.6.6 MB954 PC interface chip

Table 21 lists the PC interface chip available in the MB954 board to allow I/O interface to the 
STM32W108.

         

1.6.7 MB954 battery holder

         

1.7 Software

STM32W-SK

The starter kit package contains the following software components:

• One CD-ROM including PerytonsTM network analyzer.

• One CD-ROM including the IARTM Limited 30-days Evaluation Compiler.

Note: STM32W108B-SK also contains one CD-ROM including the RaisonanceTM Development 
Suite for the STM32-Primer2.

STM32W-EXT

No CDs are delivered with the extension kit package.

Table 20. MB954 jumper configuration

Label Configuration

JP1 Power Mems, temperature sensor and infrared LED

P2

1-2: battery powered

2-3: reserved

3-4: USB or JTAG powered

Table 21. MB954 PC interface chip

Revision Type Part

Rev. A PC I/O FTDI FT232R

Rev. B, C PC I/O STM32F103TBU6

Table 22. MB954 battery holder

Type Part

2x AAA battery holder BT1
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1.8 Documentation

The starter kit package STM32W-SK contains the following documentation components: 

• STM32W108 starter kit welcome letter which briefly describes the kits targets and 
components.

Note: STM32W108B-SK also contains Raisonance STM32-Primer2 welcome letter.

The extension kit package STM32W-EXT contains an STM32W108 extension kit welcome 
letter which briefly describes the kits targets and components.

1.9 Software libraries and demonstration applications

The STM32W108xx Starter and Extension Kit boards supports the following RF Software 
libraries packages:

• ST ZigBee RF4CE software library and ZRC, ZID application profiles with 
demonstration applications for controlling an RF4CE compliant TV using an RF4CE 
compliant remote control and a RF4CE mouse, keyboard, ...

• ST SimpleMAC software library and demonstration applications targeting point-to-point 
communication scenarios based on the IEEE 802.15.4 protocol.

For a detailed description of each software package, refer to the related documentation. 

Note: Please check for the most recent RF library package versions on the STM32W 32-bit RF 
MCUs Internet webpages at www.st.com/stm32w.

1.10 Kit set-up

1.10.1 Powering on the boards

Each application board can be powered as follows: 
• Via batteries (fit 1-2 on the P2 jumper) 
• Via USB or JTAG (fit 5-6 on the P2 jumper) 

Note: 1. The jumper position 3-4 is reserved for internal usage.

2. To enable the application board temperature, MEMS and infrared sensors, fit jumper JP1.

3. MB951 USB dongle can be powered only by connecting it to a PC USB port.

The MB850 extension board is designed as an IEEE 802.15.4 application-specific 
daughterboard. It must be connected to the STM32-Primer2 extension connector to be 
powered through the STM32-Primer2. The MB850 should be connected with the 
STM32W108 visible. 

1.10.2 Installing drivers for USB virtual COM

In order to use the serial communication channel on an application board, a driver for the 
FTDI USB<-> Serial converter or a Virtual COM port driver for an STM32F103xx must be 
installed. The correct driver to install is based on the application board revision number. 

The following application boards requires the driver FTDI USB <-> Serial converter: 
• MB851 Rev A
• MB851 Rev B
• MB954 Rev A
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The related drivers can be downloaded from the FTDI website at 
www.ftdichip.com/Drivers/D2XX.htm.

All other application boards require the STMicroelectronics Virtual COM port driver which is 
provided within each RF software library package.

1.10.3 Setting up the application serial communication channel 

To get full access to all the available commands, some demonstration applications may 
require that the application board is interfaced with the user through a serial communication 
channel (virtual COM through USB). To set a serial communication channel for the 
application board, follow these steps:

1. Where applicable, fit the application board jumper P2 on position 5-6 (power via USB).

2. Connect a mini USB cable to the application board mini-USB connector and to a PC 
USB port.

3. Right-click on My Computer, select Manage, Device Manager, and open Ports (COM 
& LPT) to display the related USB COMx port.

4. Open a hyper terminal on the corresponding USB virtual COMx port with the following 
configuration:
– Bit rate: 115200
– Data bits: 8
– Parity: None
– Stop bits: 1
– Flow control: None

The STM32-Primer2 and MB850 demonstration applications use the STM32-Primer2 
resources (LCD, joystick with button, touch screen display) as I/O communication channels.
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2 Running the STM32W108xx kits

STM32W-SK

In the STM32W-SK starter kit (STM32W108B-SK), the following applications are 
preprogrammed: 

• Two CircleOs applications preloaded in the STM32-Primer2:

– ZigBee RF4CE RC application

– SimpleMAC sun sample application 

• One Perytons capture firmware (application board labeled as “Analyzer”)

In the STM32W-SK starter kit (STM32W108C-SK), the following applications are 
preprogrammed: 

• One SimpleMAC planet application (application board labeled as "Planet")

• One Perytons capture firmware (application board labeled as “Analyzer”)

• A USB dongle with SimpleMAC planet application 

You can also start a packet capture session using the Perytons analyzer (see Section 3.2: 
Network analyzer for more details).

STM32W-EXT

In the STM32W-EXT extension kit, all four boards are preprogrammed with SimpleMAC 
planet firmware (application board labeled as "Planet"). 

Using these boards, you can extend the sun, planet point to point network with other four 
planet nodes.

2.1 Installing the STM32W108xx kit software tree

To install the specific kit software tree, download the related RF software library package 
from the STM32W 32-bit RF MCUs Internet web pages.

2.2 Remote control and virtual TV (based on RF4CE library)

This section shows how to control a ZigBee RF4CE-compliant TV target using an RF4CE-
compliant remote control. The demonstration application is run using the STM32-Primer2 
and MB850 as a remote control and a PC applet for emulating a TV on your PC.

The RF4CETV PC applet implements a virtual TV supporting the following features:

• 12 channels, playing video from files

• Volume control

• Mute

• Channel change

• Play/Pause

• Pair button

• Device information

Note: STM32- Primer2 and MB850 are available only with STM32W108B-SK kit.
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2.2.1 Run the remote control (RC) and virtual TV applications

The STM32-Primer2 tool provided with the STM32W-SK starter kit (only STM32W108B-SK) 
is delivered with the RC application. This application automatically configures the connected 
MB850 extension board with the related ZigBee RF4CE RC application. 

The application board is automatically configured when launching the RF4CETV PC applet.

To run the RC and TV applications on the STM32 Primer2, MB850 and application board 
platforms, the following steps are required:

1. Connect the MB850 to the extension connector of the STM32-Primer2 tool.

2. Power on your STM32-Primer2.

3. Press the joystick button to launch the Main Menu and select Applic.->RF4CE RC.

If everything is properly done, the LCD screen displays a set of RF4CE RC commands.

4. Connect the application board to the PC using a mini USB cable with P2 fitted in 
position 5-6 (power from USB). A virtual COM port should appear in the Windows 
Device Manager.

5. From Windows, launch the RF4CETV.exe PC applet. A PC applet GUI appears.

6. Select the serial port matching the port assigned by the Windows Device Manager. If 
the firmware on the application board is not present, the application uploads the 
firmware through the serial port. Wait until LED D1 is on.

7. Push the button to start pairing with the RF4CE remote control. LED D1 starts 
blinking quickly when the node is ready for pairing (for 30 sec.).

8. On your STM32-Primer2, use the joystick to scroll between button pages until you find 
the button . Push the button to start pairing with the application board.

If everything is properly done, a message on your STM32-Primer2 screen and in the 
RF4CETV applet informs you that the pairing process has been successful.

Figure 5. RF4CETV PC applet
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2.2.2 Use the remote control (RC) and virtual TV applications

To send an RC command to the virtual TV, push the associated RC symbol on the STM32-
Primer2 touch sensing screen.

Figure 6. RF4CE RC application driving the ST Virtual TV PC applet

Note: For further information about the ST RF4CE demonstration applications, refer to the 
STM32W108xx ZigBee RF4CE library user manual (UM0909).

2.2.3 Use the virtual remote control (RC) and virtual TV applications 

The same demonstration application can be run using the ST virtual remote control (RC) PC 
applet.

The RF4CERC PC applet implements a virtual RC supporting the following features:

• Certain RC standard buttons

• Volume control

• Mute

• Channel change

• Pair button

• Paired device information

Click on From Windows to launch the RF4CERC.exe PC applet. A PC applet GUI appears.
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Figure 7. RF4CERC PC applet

Push the button  to start pairing with the ST Virtual TV and then use the RC buttons to 
drive the virtual TV. 

2.3 Basic star network (based on SimpleMAC library)

This section shows how to set up a star network supporting parent and child roles (called, 
respectively, sun and planet).

2.3.1 Run preloaded sample appl. on STM32-Primer2, MB850 platforms (only 
for STM32W108B-SK)

The STM32-Primer2 tool provided with the STM32W-SK starter kit is delivered with a 
sample application (sun image). This application automatically configures the connected 
MB850 extension board with the related sample application.

To run the sample application on the STM32-Primer2, MB850 platforms, follow these steps:

1. Connect the MB850 to the extension connector of the STM32-Primer2 tool.

2. Power on your STM32-Primer2.

3. Press the joystick button to launch the main menu and select Applic.->SM SUN. 
If everything is done properly, you get an LCD screen showing a light blue box in the 
center. This blue box represents the sun node (a network has been created).



Running the STM32W108xx kits UM0894

24/45 DocID16999 Rev 7

Figure 8. STM32-Primer2 sun node

4. Press the button again to access the application main menu. This is the first level 
option list. Options can be classified in two categories:

– Options that provide information about the sun parameters (node information, 
planets list)

– Options that execute actions (leave network, quit)

2.3.2 Run the sample planet application on the application board

To download and run the sample planet application on an application board, use the related 
IAR project provided within the SimpleMAC software library package following the 
instructions described in Section 3.3: IAR Embedded Workbench® for ARM.

2.3.3 Set up a star network using STM32-Primer2, MB850 platforms

On the planet node, press button S1 to join the network formed by the STM32-Primer2 sun 
node. Once joined, the planet LED D3 turns on and the planet node is displayed on the 
STM32-Primer2’s LCD (as a green box with the related 2-byte short address underneath). 

Figure 9. Planet device joined to the network

When a planet device sends data to the sun device (at a periodic rate), a blue line 
connecting the transmitting planet to the sun is displayed on the screen as well as the sent 
application board VDD_PADS value (in mV).

Figure 10. Planet sends data to the sun

This identifies which planet is in transmission mode if there is more than one planet device 
(up to 5 supported by the STM32-Primer2 sun application). 
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Figure 11. Sun node with 5 planets

Figure 12. Network down 

The following table summarizes the symbols appearing on the LCD screen and the 
associated events.

         

Note: For further information about the SimpleMAC sample application, refer to STM32W108xx 
SimpleMAC user manual - UM0893, available on the STM32W 32-bit RF microcontroller 
webpages at www.st.com/stm32w.

2.3.4 SimpleMAC Sun PC applet (based on SimpleMAC library)

This section shows how to set up a star network supporting parent and child roles (called, 
respectively, sun and planet) by using a PC applet targeting the SimpleMAC Sun 
application. 

The main functions of the SimpleMAC Sun PC applet are:

• Sun node forms a IEEE 802.15.4 network 

• Give all information about the sun node (channel, pan ID, node ID, eui64, tx power, ...)

• Handling planets nodes joining to the network 

• Handling planets node leaving the network once 

• Sun node leaves network

• Sun node receives data from each joined planet node

2.3.5 Run the SimpleMAC Sun PC applet 

The application board is automatically configured when launching the SimpleMAC Sun PC 
applet.

Table 23. Definition of LCD screen symbols (SimpleMAC sample application)

Symbol Associated event

Blue line connecting planet to sun Planet sends data to the sun (see Figure 10)

D Network down (see Figure 12)
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To run the SimpleMAC Sun PC applet on an application board, the following steps are 
required:

1. Connect the application board to the PC using a mini USB cable with P2 fitted in 
position 5-6 (power from USB). A virtual COM port should appear in the Windows 
Device Manager (or connect the USB dongle directly to a PC USB port).

2. From Windows, launch the SimpleMAC Sun Application.exe PC applet. A PC applet 
GUI appears.

3. Select the serial port matching the port assigned by the Windows Device Manager. If 
the firmware on the application board is not present, the application uploads the 
firmware through the serial port. 

Figure 13. SimpleMAC Sun PC applet flash image check

4. Push the button  to let the sun node form a network. If everything is done properly, 
you get the following picture: 
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Figure 14. SimpleMAC Sun node forming an IEEE 802.15.4 network

The SimpleMAC Sun PC applet is also offering these command options:

         

2.3.6 Build, download and run the sample planet application on the 
application board

To build, download and run the sample planet application on an application board, use the 
related IAR project provided within the SimpleMAC software library package following the 
instructions described in Section 3.3: IAR Embedded Workbench® for ARM.

Table 24. SimpleMAC Sun PC applet command options

Command Description

Display all information about the sun node

Display a table giving information about planets

It allows the sun node to leave the network
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2.3.7 Set up a star network using SimpleMAC Sun PC applet

On the planet node, press button S1 to join the network formed by the STM32W108xx sun 
node. Once joined, the planet node is displayed on the SimpleMAC Sun PC applet.

Figure 15. Planet device joined to the network

When a planet device sends data to the sun device (at a periodic rate), a line connecting the 
transmitting planet to the sun is displayed on the SimpleMAC Sun PC applet as well as the 
sent application board VDD_PADS value (in mV).

Figure 16. Planet sends data to the sun
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This identifies which planet is in transmission mode if there is more than one planet device 
(up to 5 supported by the SimpleMAC Sun PC applet).

Figure 17. Sun node with 5 planets

Note: For further information about the SimpleMAC sample application, refer to the 
STM32W108xx SimpleMAC user manual - UM0893, available on the STM32W 32-bit RF 
microcontroller webpages  at www.st.com/stm32w.
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3 STM32W108xx kits utilities and software tools

3.1 stm32w_flasher utility

The stm32w_flasher utility allows you to download a binary file into the STM32W108xx 
application board. This utility comes with each RF software library package. To download a 
binary image, follow these steps:

1. Where applicable, fit the application board jumper P2 on position 5-6 (power via USB).

2. Connect a mini USB cable to the application board mini-USB connector and to a PC 
USB port.

3. Using the mouse, right-click on My Computer, select Manage, Device Manager, and 
open Ports (COM & LPT) to display the related USB COMx port. 

4. Open a DOS Window on your PC.

5. Go to the utilities folder which comes after the installation process.

6. Type the following command: stm32w_flasher –p <COMx> -r –f <file_name.bin/.s37>

where COMx is the virtual COM related to the connected application board, and 
file_name.bin/.s37 is the application image to be downloaded.

Note: You can also use the stm32w_flasher utility through the JTAG programmer for all the boards 
which have a JTAG connector:

1. Fit the application board jumper P2 on position 5-6 (power via JTAG).
2. Plug the JTAG programmer to a PC USB port and to the board JTAG connector P4.
3. Open a DOS Window on your PC.
4. Go to the folder where the stm32w_flasher is located (tool or utility folder).
5. Type the following command: stm32w_flasher -f <file_name.bin/.s37> -r

3.2 Network analyzer

3.2.1 Perytons

To install the Perytons network analyzer, insert the related CD-ROM and follow the 
installation instructions. To use the Perytons network analyzer, follow these steps:

1. Application board labeled as “Analyzer“: fit jumper P2 on position 5-6 (power via USB) 
and connect to a PC USB port.

2. Open the Perytons tool (from Start, Programs).

3. For instructions about how to start a packet capture session, refer to the documentation 
on the Perytons CD-ROM.

When a packet capture session is ongoing, the application board LEDs behave as follows:

• When data is sent to the PC, LED D1 flashes for a short period.

• LED D3 is the heartbeat LED.

A prebuilt analyzer binary image for Perytons is provided with each RF software library 
package.
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3.3 IAR Embedded Workbench® for ARM

To install the IAR Embedded Workbench® for ARM, follow these steps:

1. Go to the Download section of the IAR website (www.iar.com) download section and 
select a 30-day IAR version for ARM.

2. Start the download procedure and receive a 30-day license.

3. Insert the STM32W108 Starter Kit IAR CD-ROM and follow the installation instructions 
using the 30-day licence from the IAR website.

To build the binary image of all the available demonstration applications using the IAR tool, 
follow these steps:

1. Open the IAR tool.

2. From the File > Open > Workspace menu, open the *.eww IAR project related to the 
demonstration application you are going to address.

3. From the Project menu, select Rebuild All. A binary file is built under the project folder 
specified in Project > Options > General Options Category > Output menu > 
Executables/libraries item.

To download the built binary image on the application board, follow these steps:

1. Connect the JTAG Flash programmer to the application board P4 connector and to a 
PC USB port (through a USB cable).

2. Power the application board through the JTAG: P2 jumper fitted on 5-6 position.

3. From the Project menu, select Download and Debug. The binary image is downloaded 
into the STM32W108xx Flash.

4. From the Project menu, select Stop Debugging. The application is ready to run.

Note: To use the J-Link Lite JTAG Flash programmer, you need to switch on the “power supply for 
target” feature. The first time you plug the J-Link Lite on a PC USB port, follow these steps 
(make sure that you have already installed the IAR Embedded Workbench):

1. Open a DOS Window on your PC.

2. Type jlink.

3. Issue the command: power on perm.
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4 List of acronyms

         

Table 25. List of acronyms used in the document

Term Meaning

API Application programming interfaces

ZRC  ZigBee Remote Control

ZID ZigBee Input Device

MAC Medium access control

PA Power amplifier

RC Remote control

RF Radio frequency communication

USB Universal serial bus
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5 Available board schematics

Figure 18. MB850 rev. A
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Figure 19. MB851 module
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Figure 20. MB851 rev. A
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Figure 21. MB851 rev. B
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Figure 22. MB851 rev. C

GND

Rst1
SW-PB

C14
100nF

C23
100nF

C24
100nF

GND

C25
10uF

X2
32.768kHz

C26

22pF
C27

33pF

GND

GND

S1

SW-PB

GPIO10

GPIO14

GPIO11

GPIO15

GPIO12

GPIO17

GPIO13
GPIO16

GPIO00
GPIO04
GPIO01

GPIO05

GPIO02

GPIO07

60OIPG30OIPG

GPIO08

GPIO19

GPIO09

GPIO20
GPIO18D3 Yellow

D1 Green

R7 1k

R8 1k

NC1

GND2 Vout 3

Vcc 4

GND5

U2

ST: STLM20W87F
V

dd
_I

O
1

G
N

D
2

R
es

er
ve

d
3

G
N

D
4

G
N

D
5

V
dd

6

CS7

IN
T 

1
8

IN
T 

2
9

G
N

D
10

G
N

D
11

SD
O

12

SD
A

/S
D

I
13

SCL/SPC 14

U1
ST: LIS302DL

GND

GND GND

GND

1 2

JP1

Header 2
C29
100nF

C28
100nF

C30
100nF

R12

470R

GND

GNDGND

GPIO02

GPIO01

GND GND

JTCK

nRST

nRST+VBATAAA

+
1

-
2

AAA BT1
AAA-SCK1

+VBRD

1 2
3 4
5 6

P2

Header 3X2

+VISA
+VBRD

+VBRD

+VBRD

C33
4.7uF

C32
100nF

C31
100nF

GND GNDGND GND

+VUSB

+VUSB

GPIO10
GPIO09

GPIO21

C34
100nF

GND

R15

1k

R16 1k

1 2
3 4
5 6
7 8
9 10
11 12
13 14
15 16
17 18
19 20
21 22
23 24
25 26
27 28

P1

Header 14X2

GPIO05

D5

TSHF5210

R9

10R

GPIO12
Q1
BC846W R10

1k

GND

R11
10k

+VJTAG

Byp3

Vout4 Vin 5

Shdn 1

GND 2

U3

LK112M33TR

+VBRD

GPIO22

GPIO23

D6

DIODE

D7

DIODE

R310K

R1710K

JTCK

nRST
GPIO18

GPIO19
GPIO16

GPIO20

1 2
3 4
5 6
7 8
9 10
11 12
13 14
15 16
17 18
19 20

P4

Header 10X2

+VBRD

R14
10k

Q2
BC846W

Q3
BC846W

R13

0R

R18
NC

GND

GND GND

GND

PA2/UART2TX9

Vss118 PA8 20PA9/UART1TX 21PA10/UART1RX 22PA11/USBDM 23PA12/USBDP 24PA13/JTMS 25Vss2 26

PA15/JTDI 29PB3/JTDO 30PB4/JNTRST 31PB5 32PB6/IC2C1SCL 33PB7/I2C1SDA 34BOOT0 35Vss3 36Vdd31

Vdd2 27PA14/JTCK 28

PD0/OSCIN2

PD1/OSCOUT3

NRST4

VssA5

VddA6

PA0/WKUP7

PA18

PA3/UART2RX10

PA4/SPI1NSS11

PA5/SPI1SCK12

PA6/SPI1MISO13

PA7/SPI1MOSI14

PB0/ADC12IN815

PB1/ADC12IN916

PB2/BOOT117

Vdd1 19

EPAD

IC2 STM32F103_QFN36

GND

GND

GND

R19 1k5
GND

GND

CAV1

CAV2P

C35
22pF

C15
22pF

R21
1k5

X3

8MHz

GNDGND

R23
10K

C36
100nF

GND

E01

E12

E23

GND4

SDA 5SCL6

WC7

VCC 8
U4

M24C64MW1

10OIPG20OIPG

GND

GPIO05

GPIO00

GPIO11

+VUSB

GPIO04

R22
4k7

R20
4k7

Vbus1

D -2

D+3

ID4

GND5

6

J2

USB_MINIB

R24
10k

R25
10k



A
v

aila
b

le b
o

a
rd

 sc
h

em
a

tics
U

M
08

9
4

38/45
D

ocID
169

99 R
ev 7

Figure 23. MB851 rev. D

GND

Rst1
SW-PB

C14
100nF

C23
100nF

C24
100nF

GND

C25
10uF

X2
32.768kHz

C26

22pF
C27

33pF

GND

GND

S1

SW-PB

GPIO10

GPIO14

GPIO11

GPIO15

GPIO12

GPIO17

GPIO13
GPIO16

GPIO00
GPIO04
GPIO01

GPIO05

GPIO02

GPIO07

GPIO03 GPIO06

GPIO08

GPIO19

GPIO09

GPIO20
GPIO18D3 Yellow

D1 Green

R7 1k

R8 1k

NC1

GND2 Vout 3

Vcc 4

GND5

U2

ST: STLM20W87F

V
dd

_I
O

1
G

N
D

2
R

es
er

ve
d

3
G

N
D

4
G

N
D

5
V

dd
6

CS7

IN
T

 1
8

IN
T

 2
9

G
N

D
10

G
N

D
1 1

S
DO

1 2

S
DA

/S
D

I
1 3

SCL/SPC 14

U1
ST: LIS302DL

GND

GND GND

GND

1 2

JP1

Header 2
C29
100nF

C28
100nF

C30
100nF

R12

470R

GND

GNDGND

GPIO02

GPIO01

GND GND

JTCK

nRST

nRST+VBATAAA

+
1

-
2

AAA BT1
AAA-SCK1

+VBRD

1 2
3 4
5 6

P2

Header 3X2

+VISA
+VBRD

+VBRD

+VBRD

C33
4.7uF

C32
100nF

C31
100nF

GND GNDGND GND

+VUSB

+VUSB

GPIO10
GPIO09

GPIO21

C34
100nF

GND

R15

1k

R16 1k

1 2
3 4
5 6
7 8
9 10
11 12
13 14
15 16
17 18
19 20
21 22
23 24
25 26
27 28

P1

Header 14X2

GPIO05

D5

TSHF5210

R9

10R

GPIO12
Q1
BC846W R10

1k

GND

R11
10k

+VJTAG

Byp3

Vout4 Vin 5

Shdn 1

GND 2

U3

LK112M33TR

+VBRD

GPIO22

GPIO23

D6

DIODE

D7

DIODE

R310K

R1710K

JTCK

nRST
GPIO18

GPIO19
GPIO16

GPIO20

1 2
3 4
5 6
7 8
9 10
11 12
13 14
15 16
17 18
19 20

P4

Header 10X2

+VBRD

R14
10k

Q2
BC846W

Q3
BC846W

R13

0R

R18
NC

GND

GND GND

GND

PA2/UART2TX9

Vss118 PA8 20PA9/UART1TX 21PA10/UART1RX 22PA11/USBDM 23PA12/USBDP 24PA13/JTMS 25Vss2 26

PA15/JTDI 29PB3/JTDO 30PB4/JNTRST 31PB5 32PB6/IC2C1SCL 33PB7/I2C1SDA 34BOOT0 35Vss3 36Vdd31

Vdd2 27PA14/JTCK 28

PD0/OSCIN2

PD1/OSCOUT3

NRST4

VssA5

VddA6

PA0/WKUP7

PA18

PA3/UART2RX10

PA4/SPI1NSS11

PA5/SPI1SCK12

PA6/SPI1MISO13

PA7/SPI1MOSI14

PB0/ADC12IN815

PB1/ADC12IN916

PB2/BOOT117

Vdd1 19

EPAD

IC2 STM32F103_QFN36

GND

GND

GND

R19 1k5
GND

GND

CAV1

CAV2P

C35
22pF

C15
22pF

R21
1k5

X3

8MHz

GNDGND

R23
10K

C36
100nF

GND

E01

E12

E23

GND4

SDA 5SCL6

WC7

VCC 8
U4

M24C64MW1

GPIO02 GPIO01

GND

GPIO05

GPIO00

GPIO11

+VUSB

GPIO04

R22
4k7

R20
4k7

Vbus1

D -2

D+3

ID4

GND5

6

J2

USB_MINIB

R24
10k

R25
10k



U
M

08
9

4
A

v
a

ila
b

le b
o

a
rd

 sc
h

e
m

atic
s

D
ocID

169
99 R

ev 7
3

9/45

Figure 24. MB954 module
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Figure 25. MB954 rev. A
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Figure 26. MB954 rev. B
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Figure 27. MB954 rev. C
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Figure 28. MB951 rev. B
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Modified Parity to 1 in Section 1.10.3.

Modified Section 2.2.2, Section 2.2.3, Section 2.3.3.

Inserted Section 3.4.
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delivered with latest generation of the STM32W108xx extension kit.
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Changed Figure 3: MB851 application board and Figure 4: MB954 
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Added Section 1.6: MB954 hardware description

25-May-2012 5
Removed reference to EmberZnet 4.3.0 ZigBee PRO package.

Added new MB851 and MB954 board schematics.
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